
Home » infineon » infineon CY8CKIT-005 MiniProg4 Program and Debug Kit User Guide  

Contents
1  Infineon CY8CKIT-005 MiniProg4 Program and Debug
Kit
2  Product Information
3  Important notice
4  Safety precautions
5  Introduction
6  Installing MiniProg4
7  Technical description

7.1  Connectors
8  Appendix
9  Trademarks
10  Documents / Resources

10.1  References
11  Related Posts

Infineon CY8CKIT-005 MiniProg4 Program and Debug Kit

infineon CY8CKIT-005 MiniProg4 Program and Debug Kit User
Guide

Manuals+ —  User Manuals Simplified.

https://manuals.plus/
https://manuals.plus/
https://manuals.plus/category/infineon
https://manuals.plus/infineon/cy8ckit-005-miniprog4-program-and-debug-kit-manual.pdf


Product Information

Specifications

Product Name: CY8CKIT-005 MiniProg4 Program and Debug Kit

Model Number: CY8CKIT-005

Revision: *D

Date: 2023-10-18

About this Document

The CY8CKIT-005 MiniProg4 Program and Debug Kit guide is a comprehensive document that serves as a guide
for using the MiniProg4 kit. It provides detailed information about the kit’s operation and technical description of
the board.

FAQ

Q: Can I use the MiniProg4 kit for commercial purposes?

A: The Evaluation Boards and Reference Boards provided by Infineon Technologies are intended for

laboratory usage and may not be suitable for commercial purposes. It is recommended to evaluate the

suitability of the kit for your specific application.

Q: Where can I find additional documentation for the MiniProg4 kit?

A: Additional documentation, including user guides and technical specifications, can be found on the

official website of Infineon Technologies at www.infineon.com.

Q: Are there any safety precautions I should take while using the MiniProg4 kit?

A: It is the responsibility of the user to ensure that the use of the Evaluation Boards and Reference

Boards does not cause any  harm to persons or third-party property. Please refer to the safety guidelines

provided in the user guide and follow them strictly.

Q: What should I do if I encounter any issues or have further questions about the MiniProg4 kit?

A: If you encounter any issues or have further questions, please contact Infineon Technologies customer

support for assistance. Their contact information can be found on the official website or in the

documentation provided with the kit.

About this document



Scope and purpose

This document serves as a guide for using the CY8CKIT-005 MiniProg4 Program and Debug Kit. The document
explains about the kit operation and technical description of the board. Intended audience For people who are
interested in exploring the functionality of MiniProg4.

Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board (PCB) for
demonstration and/or evaluation purposes, which include, without limitation, demonstration, reference and
evaluation boards, kits and design (collectively referred to as “Reference Board”). Environmental conditions have
been considered in the design of the Evaluation Boards and Reference Boards provided by Infineon Technologies.
The design of the Evaluation Boards and Reference Boards has been tested by Infineon Technologies only as
described in this document. The design is not qualified in terms of safety requirements, manufacturing and
operation over the entire operating temperature range or lifetime.
The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional testing
only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the same
procedures as regular products regarding returned material analysis (RMA), process change notification (PCN)
and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products and are solely intended for evaluation
and testing purposes. In particular, they shall not be used for reliability testing or production. The Evaluation
Boards and Reference Boards may therefore not comply with CE or similar standards (including but not limited to
the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other requirements of the country in which
they are operated by the customer. The customer shall ensure that all Evaluation Boards and Reference Boards
will be handled in a way that is compliant with the relevant requirements and standards of the country in which
they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are addressed
only to qualified and skilled technical staff, for laboratory usage, and shall be used and managed according to the
terms and conditions set forth in this document and in other related documentation supplied with the respective
Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the Evaluation Boards
and Reference Boards for the intended application, and to evaluate the completeness and correctness of the
information provided in this document with respect to such application. The customer is obliged to ensure that the
use of the Evaluation Boards and Reference Boards does not cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided “as is” and
Infineon Technologies disclaims any warranties, express or implied, including but not limited to warranties of non-
infringement of third party rights and implied warranties of fitness for any purpose, or for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation Boards
and Reference Boards and/or from any information provided in this document. The customer is obliged to defend,
indemnify and hold Infineon Technologies harmless from and against any claims or damages arising out of or
resulting from any use thereof. Infineon Technologies reserves the right to modify this document and/or any
information provided herein at any time without further notice.

Safety precautions

Safety precautions

Note: Please note the following warnings regarding the hazards associated with the development system.



Table 1 Safety precautions

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when installing, testing, servicing or
repairing the assembly. Component damage may result if ESD control procedures are not followed. If you are not
familiar with electrostatic control procedures, refer to the applicable ESD protection handbooks and guidelines.

Introduction

Figure 1 MiniProg4

The MiniProg4 Program and Debug Kit is an all-in-one programmer and debugger for PSoC™ 4, PSoC™ 5LP,
and PSoC™ 6 MCU devices. MiniProg4 also provides USB-I2C, USB-SPI and USB-UART bridging functionality.
The MiniProg4 provides a special feature enabling users to write their own custom firmware through the custom
application mode.

Note: The JTAG protocol for programming and debugging is supported only in the CY8CKIT-005-A revision of
Miniprog4.

Kit contents

The CY8CKIT-005 PSoC™ MiniProg4 Program and Debug Kit includes:

MiniProg4 programmer/debugger

10-pin ribbon cable

USB Type-A to Type-C cable

Quick Start Guide

Programming and Debugging

The MiniProg4 programmer/debugger provides the flexibility to work with the SWD or JTAG programming and
debugging interface. MiniProg4 supports 32-bit Arm® Cortex®-M0/M0+/M3/M4 PSoC™ devices. The MiniProg4
debugger is supported by the software tools PSoC™ Creator, ModusToolbox™ software, ModusToolbox™
Programming tools, and PSoC™ Programmer.

Bridging



MiniProg4 supports USB-I2C, USB-UART and USB-SPI as standard bridging protocols for any device. The
MiniProg4 bridging capabilities are used by PSoC™ Creator, ModusToolbox™ software, ModusToolbox™
Programming tools, PSoC™ Programmer, Bridge Control Panel, and other applications. Tuning software tools
such as the CAPSENSE™ tuner provided by Infineon also use these capabilities.

Documentation conventions

Table 1: Document conventions for user guides

Convention Usage

  

Courier New
Displays file locations, user-entered text, and source code:

C:\…cd\icc\

Italics
Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC™ Designer User Guide.

[Bracketed, Bold] Displays keyboard commands in procedures: [Enter] or [Ctrl] [C]

File > Open
Represents menu paths:

File > Open > New Project

Bold Displays commands, menu paths, and icon names in procedures: Click the File menu,
and then click Open.

Times New Roman
Displays an equation:

2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.

Installing MiniProg4

 



Installing MiniProg4

Figure 3 Bottom view

This chapter shows how to install MiniProg4 and its associated PC software.

MiniProg4

Figure 2 Top view

Figure 3 Bottom view

MiniProg4 installation

The MiniProg4 programmer/debugger is supported by PSoC™ Programmer, ModusToolbox™ software,
ModusToolbox™ Programming tools, and PSoC™ Creator. Other software, such as Bridge Control Panel, use the
PSoC™ Programmer COM layer to support MiniProg4 functionality.

Note: PSoC™ Programmer is compatible only with the Windows Operating System however, ModusToolbox™
Programming tools is compatible with Windows, macOS, and Linux. To understand the differences between
PSoC™ Programmer and ModusToolbox™ Programming tools, please see the CYPRESS™ Programming
Solutions page at https://www.infineon.com/.

1. Download and install PSoC™ Programmer or ModusToolbox™ Programming tools. Follow the on-screen

instructions to install the software. Each programming tool supports a subset of Infineon devices. See

respective tool documentation for which device each supports.

2. Launch the PSoC™ Programmer or ModusToolbox™ Programming tools and connect the MiniProg4 to the

computer’s USB port using the provided USB cable. When properly connected, and drivers have been

installed, the Mode LED either turns ON or will be ramping (slowly increasing and decreasing brightness)

depending on the mode.

Note that the MiniProg4 drivers are automatically installed.

Installing MiniProg4

https://www.infineon.com


3. In PSoC™ Programmer, to connect to the port, in the Port Selection pane, click the MiniProg4 device. Click on

the Connect/Disconnect button as shown in Figure

4. If the connection is successful, a status indicator in the lower-right corner of the PSoC™ Programmer window

turns green and shows “Connected”. You can now use MiniProg4 to program the target device by clicking the

Program button.

Figure 4 PSoC™ Programmer: MiniProg4 Connect/Disconnect and Program

For more information on PSoC™ Programmer, see Help Topics under the Help menu in PSoC™ Programmer or
press [F1].

Installing MiniProg4

In ModusToolbox™ Programming tools, to connect to the MiniProg4 probe, click Connect/Disconnect button as



shown in Figure 5.

If the connection is successful, a status indicator in the lower-right corner of the ModusToolbox™ Programming
tools window turns green and shows “Connected”. MiniProg4 can be used to program the target device by clicking
the Program button.

Figure 5 MiniProg4 Connect/Disconnect and program

For more information on ModusToolbox™ Programming tools, see View Help under the Help menu in
ModusToolbox™ Programming tools or press [F1].

MiniProg4 LEDs

MiniProg4 has three indicator LEDs – Mode (Amber), Status (Green), and Error (Red) as shown in Figure 6. Table
2 indicates the behavior of these LEDs for various operations.

Figure 6 MiniProg4 LEDs

Table 2 LED representation for various operations of MiniProg4



 

Programming mode
Programming stat
us

Three LEDs

Mode indicator (A
mber LED)

Status indicator 1 
(Green LED)

Status indicator 2 
(Red LED)

 

CMSIS-DAP HID

Programming

 

Ramping (1 Hz)

8 Hz OFF

Success ON OFF

Error OFF ON

Idle OFF OFF

 

CMSIS-DAP Bulk

Programming

 

ON

8 Hz OFF

Success ON OFF

Error OFF ON

Idle OFF OFF

Bootloader N/A 1 Hz OFF OFF

Custom application N/A 8 Hz ON ON

MiniProg4 buttons

MiniProg4 has two buttons that enable switching between various operating modes. Figure 7 shows the location
of the buttons. In order to understand switching MiniProg4 modes, see Figure 8. On power-up, MiniProg4 is in
CMSIS-DAP/BULK mode by default. If the Mode Select button is pressed, MiniProg4 enters CMSIS-DAP/HID
mode. If the Custom App button is pressed, MiniProg4 enters the custom application mode, where a user can run
their own custom applications on the MCU contained in the MiniProg4, see Figure 8. For details on LED
indications of various modes of MiniProg4, see Table 2.



Technical description

MiniProg4 is a protocol translation device. With MiniProg4, the PC host software can communicate through a USB
port to the target device to be programmed or debugged, as shown in Figure 9. Table 3 lists the protocols that are
supported by each connector. MiniProg4 enables communication with the target devices using I/O voltage levels
from 1.5 V to 5 V.

Figure 9 System block diagram

Table 3 Connectors / Communication Protocol support



Connector SWD JTAG I C SPI
UART

(with and without flow control)

5-pin Supported N/A N/A N/A N/A

10-pin Supported Supported N/A N/A N/A

6×2 header N/A N/A Supported Supported Supported

a) JTAG is supported only in CY8CKIT-005-A.

Interfaces

SWD/JTAG

Arm®-based devices support the Serial Wire Debug (SWD) and JTAG protocols. The PSoC™ 4, PSoC™ 5LP,
and PSoC™ 6 MCU device families implement these standards, which offers programming and debugging
functions. MiniProg4 supports programming and debugging of PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 devices
using SWD and JTAG through the 5-pin or 10-pin connector. Before programming a PSoC™ 4, PSoC™ 5LP, or
PSoC™ 6 MCU device, the electrical connection requirements in the respective device datasheet are reviewed or
in the PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 MCU device programming specifications. The list of datasheets and
programming specifications are as follows:

www.infineon.com/PSoC4
www.infineon.com/PSoC5LP
www.infineon.com/PSoC6

I2C

I2C is a common serial interface standard. It is mainly used for communication between microcontrollers and
other ICs on the same board but can also be used for intersystem communications. MiniProg4 uses an I2C
multimaster host controller that allows the tool to exchange data with I2C-enabled devices on the target board.
For example, this feature may be used to tune CAPSENSE™ designs. MiniProg4 serves as a USB-I2C bridge
(acts as I2C master) that can be used to communicate with a I2C slave devices through the Bridge Control Panel
software. For I2C connections use the 6×2 connector. MiniProg4 has internal pull-up resistors and supports I2C
speeds up to 1 MHz.

SPI

The serial peripheral interface (SPI) is a synchronous serial communication interface specification used for short-
distance communication, primarily in embedded systems. SPI devices communicate in full duplex mode using a
master-slave architecture with a single master. MiniProg4 serves as a USB-SPI bridge (acts as SPI master) that
can be used to communicate with an SPI slave device through the Bridge Control Panel software. For SPI
connections, use the 6×2 connector. MiniProg4 supports SPI speed up to 6 MHz.

UART with and without flow control

UART is another common serial interface standard. MiniProg4 supports UART, which allows the tool to receive
data from UART enabled devices on the target board. MiniProg4 provides UART communication both with and
without hardware flow control. In order to enable flow control, RTS and CTS pins are provided in the 6×2 I/O
header. If flow control is not required, CTS and RTS pins can be left floating. Terminal emulators such as Tera
Term or PuTTY can be used to communicate with the target PSoC™ device. MiniProg4 supports UART speed up

a) 2

http://www.infineon.com/PSoC4
http://www.infineon.com/PSoC5LP
http://www.infineon.com/PSoC6


to 115200 Baud Rate.

Reference

For more information on the PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 MCU’s JTAG, SWD, and I2C interfaces, see
the PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 Technical Reference Manuals. For more details on MiniProg4 with
Bridge Control Panel, refer to the Bridge Control Panel Help document.

Connectors

 5-pin connector

The 5-pin connector is configured as a single row with a 100-mil pitch. Suggested mating connector part number
is Molex Connector Corporation 22-23-2051.

Figure 10 5-pin connector with pin assignments

Note: If the design requires MiniProg4 to be directly plugged to the target board with a 5-pin header, adequate
mechanical clearance shall be provided near the 5-pin header on the target board. The width and height of
MiniProg4 (5-pin header area) is 25 mm × 13 mm. If the design cannot meet the required mechanical clearance,
use a stackable header (such as Proto-PIC 20690).

10-pin connector



The 10-pin connector is configured as a dual row with 50-mil pitch. It is used with a ribbon cable (provided) to
mate to a similar connector on the target board. The signal assignment is shown in Figure 11. Suggested mating
connector part number is CNC Tech 3220-10-0300-00 or Samtec Inc. FTSH-105-01-F-DV-K-TR.

Figure 11 10-pin connector with pin assignments

Technical description

Table 4 shows the summary of the protocols and related pin assignments. The pin mapping is also shown on the
back of the MiniProg4 case.

Table 4 Communication protocol pin assignments

Protocol Signal 5-pin 10-pin

 

SWD

SDIO 5 2

SCK 4 4

XRES 3 10

 

 

JTAG

TMS N/A 2

TCK N/A 4

TDO N/A 6

TDI N/A 8

XRES N/A 10

a) JTAG is supported only in CY8CKIT-005-A.

6×2 connector

This connector supports all the communication protocols like I2C, SPI, UART (with or without flow control
supported by MiniProg4). Figure 12 shows the pin assignments. They are also shown on the back of the
MiniProg4 case.

Figure 12 6×2 connector pin assignments

a)



Power

MiniProg4 can be powered using the USB interface. On kits/boards where there is a single power supply for the
entire board, MiniProg4 can supply power to the board. However, this supply is limited to approximately 200 mA,
and is protected against excess current draw. You can select 1.8 V, 2.5 V, 3.3 V, or 5 V from PSoC™ Programmer.
The 5 V supply may vary between 4.25 V–5.5 V, because it is supplied directly from the USB port. The maximum
deviation for other voltages is +5%. Note: Some PSoC™ device families do not support 5 V operation. Refer to
the respective device datasheet for supported voltage selection.

Voltage stress beyond acceptable limits can permanently damage MiniProg4. Programming signals
can withstand over-voltage up to a maximum of 12 V and a minimum of up to –5 V. Communication bridge signals
(I2C, UART & SPI) can withstand over-voltage only up to maximum 6 V and a minimum up to –1 V.

Appendix

A Regulatory Compliance information

The CY8KCIT-005 MiniProg4 Program and Debug Kit complies with the CE-Low Voltage Directive 2006/95/EC
(Europe) safety requirement. It has been tested and verified to comply with the following electromagnetic
compatibility (EMC) regulations.

CISPR 22 – Emissions

EN 55022 Class A – Immunity (Europe)

CE – EMC Directive 2004/108/EC

CE Declaration of Conformity
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Trademarks

All referenced product or service names and trademarks are the property of their respective owners.

WARNINGS

Due to technical requirements products may contain dangerous substances. For information on the types in
question please contact your nearest Infineon Technologies office. Except as otherwise explicitly approved by
Infineon Technologies in a written document signed by authorized representatives of Infineon Technologies,
Infineon Technologies’ products may not be used in any applications where a failure of the product or any



consequences of the use thereof can reasonably be expected to result in personal injury.

IMPORTANT NOTICE

The information given in this document shall in no event be regarded as a guarantee of conditions or
characteristics (“Beschaffenheitsgarantie”). With respect to any examples, hints or any typical values stated
herein and/or any information regarding the application of the product, Infineon Technologies hereby disclaims
any and all warranties and liabilities of any kind, including without limitation warranties of non-infringement of
intellectual property rights of any third party. In addition, any information given in this document is subject to
customer’s compliance with its obligations stated in this document and any applicable legal requirements, norms
and standards concerning customer’s products and any use of the product of Infineon Technologies in customer’s
applications.

The data contained in this document is exclusively intended for technically trained staff. It is the responsibility of
customer’s technical departments to evaluate the suitability of the product for the intended application and the
completeness of the product information given in this document with respect to such application.

Edition: 2023-10-18

Published by: Infineon Technologies AG 81726 Munich, Germany

© 2023 Infineon Technologies AG. All Rights Reserved.

Do you have a question about this document?

Email: erratum@infineon.com

Document reference: 002-19782 Rev. *D
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